
 Vantage Tempo Guide       
163833 June 2015 



Copyrights and Trademark Notices
2

Copyrights and Trademark Notices
Copyright 2015 by Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, 
Lightspeed, ScreenFlow, Switch, Vantage, Wirecast, GraphicsFactory, MetaFlip, and 
Split-and-Stitch are registered trademarks and Pipeline, MacCaption, and e-Captioning 
are trademarks of Telestream, LLC. All other trademarks are the property of their 
respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All right 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
Explorer, SQL Server 2005|2008|Server 2012, and Windows Media Technologies are 
trademarks of Microsoft Corporation.
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SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler. 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.
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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.
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Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
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Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Part number: 163833

Date: June 2015
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Introduction to Tempo
What’s In This Guide?
This guide provides an overview of what Tempo is, how to create Tempo workflows and 
compositions, and how to use the Tempo Portal to produce re-timed media assets. 

The guide includes these chapters:

■ Introduction to Tempo

■ Configuring Tempo

■ Tempo Workflows

■ Using Tempo

What’s In This Chapter?
This Introduction chapter includes these topics:

■ What Is Tempo?

■ How Does Tempo Work?
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What Is Tempo?
Tempo™ is a complete solution designed specifically for re-timing file-based content—
intelligently decreasing or increasing the running time of shows and segments by 1% 
to 10%. Tempo comes packaged as a turnkey system, including a Lightspeed Server, 
preinstalled Vantage system, and preconfigured Tempo option. 

Using new time compression algorithms, Tempo can re-time the complete asset, not 
just the beginning, to deliver superior quality and faster turn-around times. Instead of 
throwing away frames as other technologies do, Tempo intelligently interpolates the 
time change over the content duration, resulting in a pristine output with no 
noticeable visible or audible artifacts.

Tempo runs on the Vantage media processing platform and Lightspeed Server, 
providing unparalleled media quality:

• Tempo is a turnkey system consisting of Tempo software running on the latest Van-
tage media processing platform and Telestream Lightspeed Server hardware. 
Tempo includes Vantage Transcode Pro.

• Tempo connects seamlessly to other Vantage or third-party systems to create a 
powerful automated workflow – all under unified system control.

• Tempo can shorten or lengthen an existing asset’s running time from 1% to 10% 
without noticeable loss of video or audio quality.



Introduction to Tempo
How Does Tempo Work?

13
How Does Tempo Work?
The following topics describe briefly how Tempo works. This information will give you 
the background needed to understand Tempo workflows and to use the Tempo Portal.

Video
Tempo begins the re-timing process by analyzing each interpolated frame and 
predicting which elements can be adjusted for time compensation. Then it applies the 
re-timing over the duration of the content, or to the segments you identify for retiming. 
Since the entire file (or segment) is analyzed to determine the best candidate frames for 
adjustment, the desired time compression is applied longitudinally rather than at 
random intervals.

Segmentation
Tempo changes are applied to either the entire duration of a clip, or to individual 
segments from the source file which are then assembled in a specific sequence to 
create the target file. By default the content consists of a single segment spanning the 
entire duration of the source file.

Segmentation identifies sections of the file that are eligible or ineligible for tempo 
changes. A section may be considered ineligible if any of these criteria apply:

• A Tempo change is not required (for example, bars, slate, etc.)

• A Tempo change is not permissible (for example, barter spots).

• A Tempo change would introduce unacceptable artifacts.

Segmentation allows the target file to contain a subset of the source file. This capability 
allows a segment to be excluded (for example, to remove an existing commercial) or 
inserted (such as to replace a texted shot with a textless version).

Segmentation identifies which sections of the file contribute to the source program 
duration. Tempo changes are then applied to each eligible segment in order to achieve 
the target program duration.

The target program duration may be specified as either an absolute value (such as 
00:30:00;00) or a value relative to the source duration (such as +/- 00:01:00).

Audio
Tempo performs compression operations on audio with equivalent timing for the 
video. Pitch correction is applied using a special synchronous technique that preserves 
the original sound pitch. 
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Captions
Caption data (608 and 708) is redistributed to maintain the original presentation times 
without exceeding bandwidth limitations.

Formats
Tempo supports many input and output formats and wrappers. For a list, consult the 
Vantage Transcode encode and decode format sheets on the Telestream.net web site.

http://www.telestream.net/pdfs/datasheets/Vantage_6.3_Format_Encode_Sheets.pdf
http://www.telestream.net/pdfs/datasheets/Vantage_6.3_Format_Decode_Sheets.pdf
http://www.telestream.net
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Configuring Tempo
This chapter explains how to configure a Tempo Portal, catalogs, and binders so that 
your media proxies can be made available for configuring in the Tempo Portal. You will 
need to complete these configuration tasks to make Tempo fully ready to use.

This chapter includes these configuration topics:

■ Licensing Tempo

■ Configuring Tempo

– Add Vantage Users

– Create Vantage Stores

– Set the Tempo Session Limit

– Create Catalogs

– Create Proxies and Thumbnails

– Create a Tempo Portal Configuration

– Deploy Portals on Client Machines
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Licensing Tempo
Tempo normally comes as a turnkey system installed and fully licensed on a Lightspeed 
K80 Server. If you purchased a turnkey system, skip this topic and go on to the next one.

If you are adding the Tempo option to an existing Vantage system, get the Tempo 
license from Telestream Sales at enterprisesales@telestream.net or phone 530-470-
1300, and install the license as explained below.

Note: Tempo can be licensed only on a Lightspeed K80 Server. The license will not 
function on any other server type.

To install a Tempo license, follow these steps summarized from the Vantage Domain 
Management Guide:

1. Place a copy of the license file in a location accessible to the Tempo Server.

2. Start the Vantage Management Console by double-clicking its desktop icon.

3. In the Vantage Management Console left panel, select Licenses.

4. In the right panel, click the Add License button to display the Add/Update License 
dialog.

5. Navigate to the license location, select the license, and click Open. 

If this computer has an Internet connection, Vantage prompts you to accept the 
license agreement. If an error message appears, see Troubleshooting License Installa-
tion Problems in the Vantage Domain Management Guide to activate the license 
without an Internet connection.

6. Click I Accept... if you agree to the license terms, and click OK.

7. Read the Licensing Changed dialog and click OK.

This completes license installation. The Vantage Tempo feature should now be enabled.

mailto:enterprisesales@telestream.net
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring Tempo
Configuring a Tempo system is essentially a subset of the tasks required to set up a 
Vantage system, including creating stores, catalogs, binders, portal configurations, 
workflows, and deploying the Tempo Portal on client machines. 

If you are familiar with those tasks, you may be able to skip the detailed steps presented 
below and simply skim each topic for any special details before performing the task. If 
you are not familiar with the these tasks, detailed steps are provided to guide you. 

The following topics describe the Portal configuration tasks:

 Add Vantage Users

 Create Vantage Stores

 Create Catalogs

 Create Proxies and Thumbnails

 Create a Tempo Portal Configuration

 Deploy Portals on Client Machines
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Add Vantage Users
Before anyone can use the Vantage Tempo system, you must add them as users:

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the Settings & Options > General panel, check Enable user administration, which 
must be enabled in order to manage users. You can also select Use Windows Active 
Directory for Users to allow logging in using Windows accounts.

3. In the components panel, select Users.

Vantage displays the Users detail panel shown in Figure 1.

Figure 1. Users Detail Panel

Adding Users
The procedure to add users differs slightly depending on whether you use Windows 
Active Directory or not. Figure 2 shows the two different Add User windows. 

Figure 2. Add User Dialogs
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Adding Users Without Windows Active Directory

To add a new user without using Windows Active Directory, follow these steps:

1. Click the New User button  or right-click and select New User. 

2. Enter the username and password (and confirm the password) in the dialog box. 

3. Check the Administrator check box if you want the new user to be an administrator. 

4. Click OK to add the user, and then click Save   to save your changes.

Adding Users With Windows Active Directory

The Vantage Active Directory feature allows you to create users and groups in Windows 
Active Directory and add them as users with or without administrator privileges:

1. Click the New User button  or right-click in the empty user list and select New User. 

2. Enter part or all of the user name in the blank field and click Find Now to search for 
and list users whose names match the text you entered. 

The drop-down menu lets you select a filter for your search, and the Users and 
Groups check boxes allow searching for users, groups, or both (default).

3. Select a user in the displayed list.

4. Check the Administrator check box if you want the new user to be an administrator. 

5. Click Add to add the user, and then click Save  to save your changes. 

Setting Passwords
To set the password of a user, click the Set Password button (or right-click the user in 
the list and click Set Password). When the dialog box displays, enter the password (and 
confirm the password) of the user. Click OK to close the dialog box, then click the Save 
button  to save your changes.

Removing Users
Users can be removed by selecting the user in the Users list and clicking the Delete 
button  at the top of the User Management panel (or right-click the user and select 
Delete). 

Importing and Exporting Users
User lists can be imported and exported. To import a list of users, click the Import 
button , navigate to the XML file containing a list of users, and click the Open button. 
To export a list of users, click the Export button  (or right-click the list and select 
Export), enter an XML filename for the list of users, and click the Save button.
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Create Vantage Stores
Before you can begin configuring Tempo, you must have a fully configured Vantage 
system with Vantage Stores (folders) for holding interim results of Vantage and Tempo 
workflow processing. The stores are where Tempo will place temporary output media 
and other files that it produces before you use other workflows to move them to their 
final destination, such as a media or broadcast server. 

If you have not already done so, create Vantage Stores as follows (or skip this topic if 
your stores are already configured). For additional details about stores, See Managing 
Vantage Stores in the Vantage Domain Management Guide.

Note: When creating a store to hold proxy files viewed in the Tempo Portal, you may 
want to reference the store with a UNC path. Some SAN clients do not allow frame-
accurate representation of proxies when using shared drives.

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the components panel, select Storage > Vantage Stores.

A list of Vantage Stores opens in the right panel.

3. Click the New Vantage Store button  in the toolbar to display the Add New Store 
dialog (or right-click and select New Vantage Store).

4. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

5. Specify the store root directory with a UNC path (recommended):

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and select the root directory for the 

store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines in the 
Vantage Domain Management Guide.

6. To specify the store root directory with a drive letter path, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage in the Vantage Domain 
Management Guide.

7. Click OK.

8. Click the Save button  to save the new store.

Set the Tempo Session Limit
The Session Limit for each Vantage service determines the maximum number of 
concurrent sessions for a service. This value is displayed in the Vantage Management 
Console > Services > Session Limit display column. 

The recommended Session Limit for Tempo is 2. The default Session Limit is 4. 

To change the Session Limit:

1. Access the Vantage Management Console > Services panel. 

2. Right-click the Edit service, and select Enter Maintenance Mode.

3. Select the Setup tab at the bottom of the window. 

4. Click the Service Limits Configuration Item, and set the Session Limit to 2. 

5. Click Apply.

6. Right-click the Edit service again, and select Exit Maintenance Mode.

Note: Changing the Edit service Session Limit affects all Edit actions (Conform, etc.).

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Create Catalogs
The starting point for organizing Tempo media assets is the catalog. Operators access 
media in the Tempo Portal by first specifying catalogs and then selecting binders 
(media files with metadata and variables) from the catalogs.

Using the Vantage Management Console, you need to create at least one catalog to 
contain proxy and thumbnail files:

1. Start the Vantage Management Console by double-clicking the desktop icon.

2. In the components panel, select Catalogs.

Vantage displays the Catalogs details panel shown in Figure 3.

Figure 3. Catalogs Details Panel

3. Click the New Catalog button  in the toolbar (or right-click in the empty catalog 
space and select New Catalog).

The Management Console adds a new catalog in the catalog tree with its name 
highlighted so you can change it.

4. Type a name for the new catalog and then click on the background to set the name. 
You may want to choose an easily recognizable name such as “Tempo Catalog.”

Adding Folders
Inside each catalog, you can create as many folders as you need to organize the media 
in this catalog. Folders can be created in a hierarchy, and you can drag them around to 
re-organize them.

1. Click the catalog or folder where you want to create a new folder.
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2. Click the Add Folder button  in the toolbar (or right-click and select New Folder).

The Vantage Management Console displays a new folder in the catalog explorer 
panel and also in the Folders panel, with the default text selected. 

3. Type a name for the new folder and click on the background to set the name.

Setting the Folder Expiration Policy
A catalog or folder expiration policy defines the default expiration policy for all binders 
in the catalog or folder. If you change the expiration for existing binders in a catalog or 
subfolder, the same policy applies to new binders added to that catalog or folder. 

The catalog/folder expiration policy can be overridden by a binder expiration policy. 

To configure the binder expiration policy, do the following:

1. Right-click a catalog or folder to configure, and select Properties (Figure 4).

2. Edit the binder expiration date or check the Never Expire checkbox. Checking apply 
to subfolders applies the expiration date to all folder levels in the catalog.

3. Check Transient if you want a catalog or folder to be deleted when all binders it 
contains expire, leaving it empty. If Transient is not checked, the catalog or folder is 
not deleted when empty.

4. Check apply to subfolders to apply the Transient attribute to all folder levels in the 
catalog, or leave it unchecked to apply the attribute only to the current level. 

5. Click OK.

Note: The expiration policy can be set for individual binders when they are registered 
in a catalog; this is done using the workflow Register action.

Figure 4. Catalog Properties
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Create Proxies and Thumbnails
Before media files can be re-timed using the Tempo Portal, they must first be processed 
by an ingest workflow that performs these operations:

• Ingests the original media file for processing via a Watch action

• Flips the media file to create thumbnail, proxy, and duplicate media files

• Registers the thumbnail, proxy, and duplicate media files into a catalog

Vantage Tempo uses all these files in the Tempo Portal as follows:

• A proxy is a small QuickTime duplicate of an original file that is faster to process:

– Use the QuickTime encoder to create a QuickTime H.264/AAC MOV proxy file 
with a timecode track included in the container. 

– The encoded proxy file must have the same frame rate and timecode notation as 
your original production media. 

– For SD proxies (4:3) use a 640 x 480 frame size. For HD proxies (16:9) use 640 x 360. 

– Assign the nickname Vantage Proxy, which the player automatically recognizes. 

• A thumbnail is a JPEG snapshot of key frames in the original file displayed in the 
Tempo Portal Catalog binder list to visually represent the binders (media clips).

• Duplicate media files are created and processed so that the original is not altered.

To create and register proxies, thumbnails, and media into catalogs:
1. Use an ingest workflow from Telestream or created to suit your own needs to 

process all media assets you plan to re-time in Tempo. 

An example Ingest Workflow is described in the Tempo Workflows chapter of this 
guide. The ingest workflow you use must create and register proxies, thumbnails, 
and media files in your Tempo catalogs.

2. Access your Tempo catalogs by selecting Catalogs in the Vantage Management 
Console to verify that the catalogs contain the expected proxies, thumbnails, and 
duplicate originals. You can use the preview player to examine the media files in 
the Media Files list, if necessary.

3. Add any Metadata Labels or Attachment files using the provided tabs and toolbars. 

Metadata labels allow you to specify information about the media that can be 
passed on to workflows for use downstream. Attachments can be sidecar files used 
downstream, such as closed captioning files.

a. Click the Add button in the Metadata Labels or Attachment panel.
b. Select the label or attachment in the pop-up window and add information. 

Once the necessary files are created and registered into catalogs, other workflows can 
use them and operators can access them in the Tempo Portal to re-time them. 
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Create a Tempo Portal Configuration
Before you can use Tempo, you will need to configure the Vantage Workflow Portal to 
convert it into a Tempo Portal. As you make configuration selections according to the 
following instructions, you are modifying the Workflow Portal panels and labels. These 
topics are covered:

■ Selecting the Tempo Configuration Mode

■ Configuring Tempo Settings

■ Setting Browsable Access to Catalogs

■ Configuring the Binder Details View

■ Configuring Labels Visibility

■ Configuring Variables Visibility

■ Configuring Graphic Settings

■ Configuring Embedded Metadata

■ Configuring Workflow Forwarding

■ Configuring Storage

■ Managing Configurations

To configure the Workflow Portal to create a Tempo Portal, follow these steps:

1. Start the Vantage Management Console and connect to the Vantage domain.

2. Select Application Configurations > Workflow Portal. 

As shown below, the Workflow Portal panel displays the options for Vantage Work-
flow Portal configurations.

Figure 5. The Tempo Portal Configuration Panel
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3. Click the Create configuration button .

4. Click in the Name field, and name the new configuration Tempo Portal.

5. Click the Save button  to save your new Tempo Portal configuration.

The Tempo Portal configuration is added to the Configuration list. If you want to 
make changes to the configuration later, select the configuration in the Configura-
tion list, make your changes, and click Save to resave the configuration.

Selecting the Tempo Configuration Mode
The Workflow Portal can be configured for various modes that arrange Portal controls 
according to the tasks to be performed. Selecting the Mode essentially creates the type 
of Portal available to you. 

Set the Mode as follows to create a Tempo Portal:

1. Select the Tempo Portal configuration in the Configuration list.

2. Select Re-time Asset from Catalog (create binder) from the Mode drop-down menu.

3. Click the Save button  to save your new Tempo Portal configuration.

This selection makes the Workflow Portal into a Tempo Portal.

Configuring Tempo Settings
The Tempo Portal includes a tab and panel for Tempo Settings where you can specify 
standard settings to use for increasing or decreasing media duration:

1. Select the Tempo Portal configuration in the Configuration list.

2. Select the Tempo Settings tab (Figure 6).

Figure 6. Tempo Settings Tab
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3. Select re-timing default settings in the Tempo Portal:

–  Preserve and re-time captions: Includes captions in the retiming process. 
Check Read Only to disallow changing this setting in the Portal.

– Set timecode at: Determines where to start timecode for the re-timed output. 
You can preserve existing source timecode, start timecode at the first or last 
frame of the program, or the first or last frame of the output file. 

– Re-Time: Retimes the media to increase or decrease its duration by the Amount 
selected or to match an overall target duration for the entire program.

– Amount: Allows setting the amount of re-timing in frames per second. The 
display shows the hours, minutes, seconds, and frames setting. 

4. Click the Save button  to save your changes.

Setting Browsable Access to Catalogs
Tempo allows you to specify which catalogs (and their binders) are accessible to users 
of the Tempo Portal:

1. Select the Tempo Portal configuration in the Configuration list.

2. Select the Browsable Catalogs tab (shown in the previous figure).

3. To make a catalog visible to Portal users, select the catalog in the Available list in the 
left panel, and click Add. This moves the catalog to the Visible to user list on the 
right. 

4. To remove a catalog from the Visible to user list, select the catalog and click Remove.

5. Click the Save button  to save your changes.

Only catalogs (and their binders) in the Visible to user list on the right can be seen by 
Tempo Portal users. 

Figure 7. Browsable Catalogs Tab

Selecting the Show Media Nicknames List Option

The media list displays the media files for a binder/job that you select in the binder list. 
For example, the media list might include the original media submitted to a workflow 
and the output media from that workflow. When the media list is visible, operators can 
play the media or view the contents of the folder that contains the media.
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To display the media list, check the Show media nickname list check box in the 
Browsable Catalogs panel.

Click the Save button  to save your changes.

Selecting the Require All Expected Nicknames Option

When you create a catalog-based configuration, Vantage allows you to define whether 
or not media files, labels, and attachments referenced in the target workflow are 
required in the ingest workflow. If you require these assets, Vantage does not process 
ingest workflows that are missing these items. If you do not require these assets, 
Vantage does not check the ingest workflow for the assets and attempts to process the 
ingest workflow.

Note: A target workflow can fail if required assets are not provided by the ingest 
workflow.

To configure asset requirements for ingest workflows, check the Require all expected 
nicknames check box in the Browsable Catalogs panel.

Click the Save button  to save your changes.

Enabling and Disabling Binder Deletions

By checking the Allow Binder Delete check box, you are allowing operators to remove 
binders from the catalog after the associated jobs are submitted, leaving only binders 
that have not yet been processed. This effectively makes the catalog a manually-
managed task list that operators can control at their discretion. 

If you prefer to save binders and do not want operators to delete them, uncheck the 
Allow Binder Delete check box. 

Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action or catalog configuration.

Click the Save button  to save your changes.

For more information about how binders are handled, see Understanding Binders in the 
Vantage Domain Management Guide.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring the Binder Details View
Vantage allows you to control the columns and metadata label parameters displayed in 
the Portal binder list by making selections in the Binder Details View panel (Figure 8). 

Figure 8. Binder Details View Tab

1. Select the Binder Details View tab in the Tempo Portal Configuration.

2. Select each check box to display the item, or clear the check box to hide it:

– Binder name: Displays the name assigned to the binder when it was created.

– Created: Displays the date and time the binder was created.

– Expiration: Displays the date and time the binder expires.

– Play button: Displays a button that the operator can use to play or pause the 
selected job.

– Submit button: Displays a button to submit a job to another workflow.

Note: Vantage allows you to hide all columns in the binder list, which also causes no 
binders to appear in the list. You should configure at least one column to display so 
that binders show up in the list.

Note: The play button operates only when the workflow has generated and 
registered a proxy file (see the Using Workflow Portal topic in the Vantage User’s Guide). 
The Submit button appears only when target workflows are selected on the Forward 
to Workflows tab.

3. Click the Column button .

4. For each metadata label parameter you want to display in a column:

a. Select a metadata label in the Labels panel.
b. Select the check box for the metadata label parameter in the Parameters panel.
c. When you are done making changes, click OK.

5. For each metadata label parameter you want to remove from the binder view:

a. Select the parameter you want to delete in the parameter list.
b. Click the Delete button  and confirm the deletion.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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6. To change the displayed order of parameters:

a. Select a parameter in the list (Ctrl-click or Shift-click for multiple selections)
b. Use the green up  and down arrow  buttons to move the variables.

7. Click the Save button  to save your changes.

Configuring Labels Visibility
Vantage allows operators to view and set metadata labels when they submit jobs to a 
workflow. These labels can be used by the workflow to customize job processing.

Note: Before a metadata label can be made available to users, it must be defined 
using the Vantage Management Console. See Creating Metadata Labels and also 
Understanding Metadata Labels in the Vantage Domain Management Guide.

Only those labels are visible that are set in the workflow and configured to be visible in 
the portal configuration: 

1. Select the Labels tab (Figure 9) in the Tempo Portal Configuration.

2. To enable visibility of metadata labels, select the Show Metadata Labels check box.

3. To allow operators to add and delete metadata labels to binders, select the Allow 
Add/Delete check box.

4. To make metadata labels available to operators, select labels in the Available panel. 
(Ctrl-click or Shift-click to select multiples) and click Add.

5. To change label order, select labels in the Visible to user list (Ctrl-click or Shift-click to 
select multiples) and use the green up  and down arrows  to move the labels.

Figure 9. Labels Tab

6. Click the Save button  to save your changes.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring Variables Visibility
Vantage allows operators to save values and settings in the portal as variable values. 
These values may then be passed to the workflows specified in the Forward to 
Workflows tab to affect downstream processing.

Note: For an introduction to Vantage variables, see Understanding Variables in the 
Vantage Domain Management Guide.

To enable operator use of variables, follow these steps:

1. Select the Variables tab (see Figure 10) in the Tempo Portal Configuration.

Figure 10. Variables Tab

Note: Before a variable can be made available to an operator, it must be defined 
using the Vantage Management Console as described in Creating Variables in the 
Vantage Domain Management Guide.

2. To make variables available to operators, select their check boxes. Variables not 
checked will not be available.

Note: When all variables are hidden from operators, the Variables tab does not show.

3. Select the variables to generate from the drop-down menus on the right.

4. Select the Embedded Metadata Settings tab, and select variable features. The 
available features will vary depending on the variables you selected.

5. Click the Save button  to save your changes.

Note: If you are testing your Vantage Workflow Portal configuration, variables are 
only visible to operators after they select a binder and target workflow and click 
Submit.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Configuring Graphic Settings
The Graphic Settings tab allows you to select and set the display parameters for a 
station branding logo (bug) and for a content rating image. The branding logo can be 
added to a segment in the Tempo Portal by checking the Branding during segment 
check box for that segment. The content rating image is displayed by checking the 
Rating graphic at start check box for that segment.

Figure 11. Graphic Settings Tab

Content Branding Logo or Rating Image Configuration

To configure the Content Branding logo or Rating image, follow these steps:

1. Click the Content Branding or Rating drop-down menu to access the settings.

2. Click Browse to specify the path to the logo, or click Placement & duration and select 
Custom to change settings for the Rating image. (Note that not all settings listed 
below for the logo are available for the Rating and vice versa.)
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3. Modify the positioning and appearance settings:

The origin or default starting point for the logo or image is in the top left corner.

– Fill Method: Specify how a video overlay logo (such as a .MOV file) should be 
displayed if it is shorter than the branding duration.

None - Overlay logo video plays once and disappears.

Hold - Overlay logo video plays once and freezes on the final frame for the 
remaining branding duration.

Loop - The overlay logo video repeats for the branding duration.

– X, Y: Enter x and y coordinates for the graphic location. Select units in percentage 
or pixels from the drop-down menu.

– Width, Height: Enter graphic dimensions. Select units in percentage or pixels.

– Opacity: Enter the percentage of logo opacity.

– Duration: Enter the length of time that the graphic will appear in the segment in 
minutes, seconds, or frames. Check Entire segment if you want the logo on 
throughout the segment.

– Frequency: Enter how often the logo will appear in minutes, seconds, or frames.

– Fade duration: Enter graphic fade in and fade out duration in seconds or frames.

Configuring Embedded Metadata
The Embedded Metadata tab allows you to configure default content ratings that you 
want to show up in the Tempo Portal Embedded Metadata panel: 

• Select the default Rating system (MPA, US TV, Canadian English, Canadian French)

• Select the default Rating.

• Check the content descriptions you want checked by default.

Select Read Only for any item you do not want the Tempo Portal operator to be able to 
change.

Figure 12. Embedded Metadata Tab
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Configuring Workflow Forwarding
Tempo Portal operators complete the re-timing process by forwarding the XML re-
timing composition file to the Tempo re-timing workflow where the re-timing process 
actually occurs. 

Operators can forward to any visible target workflow by selecting the workflow on the 
Forward to Workflows Portal tab and clicking Submit. If a target workflow is required, it 
is automatically selected on the Forward to Workflows tab and the binder is forwarded 
to the required workflow when the operator clicks Submit. 

For workflows to be visible to the operator, they must be added to the Visible to user 
column in the Forward to Workflows tab.

1. Select the Forward to Workflows tab (Figure 13) in the Tempo Portal Configuration.

Figure 13. Forward to Workflows Tab

2. To enable operator viewing of target workflows, select the Show Forward to 
Workflows check box.

Note: If you disable operator viewing of target workflows, you also disable operator 
forwarding to target workflows, if “Req’d” is not checked. When “Req’d” is checked, 
operators can submit to the required workflows even though they can’t see them.

3. To make target workflows available to operators, select one or more workflow 
names in the Available panel and click Add.

Note: To accept forwarded binders, the target workflow must contain at least one 
Receive action. The Available panel only displays workflows that contain a Receive 
action.

4. To specify whether a target workflow is required for forwarding or optional, check 
the Req’d check box next to the workflow in the Visible to user panel.

5. Click the Save button  to save your changes.
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Configuring Storage
The XML compositon files created by the Tempo Portal can be stored in any Vantage 
store or folder. The Storage tab lets you select the storage location.

Note: The Microsoft User Account Control (UAC) feature may deny access to Vantage 
stores or folders that are placed in protected locations. If Vantage users report that 
access to a Vantage store or folder is denied, do one of the following: 
1. Place the store or folder in a directory that is not protected by UAC. 
2. Use the procedure below to specify a different store or folder.
3. Disable UAC on the Vantage server that hosts the store or folder.

1. Select the Storage tab in the Tempo Portal Configuration.

2. Choose an option:

a. To store files in any available Vantage store, select Available Vantage Store.
b. To store the files in a specific Vantage store or folder, select Vantage Store/Folder, 

and choose a Vantage store or folder from the drop down list.

3. Click the Save button  to save your changes.

Figure 14. Storage Tab

 

Managing Configurations
Once your Portal configuration is complete, you can manage it in these ways by 
selecting the configuration in the list and using the following toolbar buttons: 

• Click the Refresh button  to refresh the configuration list.

• Click the Delete button  to delete the configuration.

• Click the Duplicate button  to create a copy of a configuration.

• Click the Export button  to export a single configuration as an XML file, or select 
Export all from the Export button drop down menu to export all configurations.

• Click the Import button  to import a previously exported configuration XML file.

• Click the Save button  to save configuration changes.

You can also right-click on a configuration or in the blank area below the configurations 
to open a context menu providing access to the same tools described above.
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Deploy Portals on Client Machines
As a Vantage domain administrator, you can make it easier for operators to start using 
the Tempo Portal by doing the following:

1. Install the Vantage client programs on operator workstations. 

a. Log on to the target workstation with a local administrator account, and make 
sure that virus-checking software and Windows Firewall is off.

b. Copy the Vantage 6.3 Client Application.msi installer or the Vantage_6.3_Setup.exe 
installer to the workstation, or make the installer available on a network share.

c. Run the Vantage 6.3 Client Application.msi installer or the Vantage_6.3_Setup.exe 
installer, and select the Vantage Workflow Portal and any other desired clients for 
installation.

2. Launch and configure the Vantage Workflow Portal for the first time:

a. Select the Vantage domain (File > Change Vantage Domain).
b. Load the Tempo Portal configuration (File > Change/Reload Application 

Configuration...)
c. Select the Tempo catalogs, which will make the Tempo clips (binders) available 

for selection and processing by the operator.

Tempo is now ready for use. The next steps are to import or create Tempo workflows as 
explained in the Tempo Workflows chapter and to begin using the Tempo Portal as 
explained in the Using Tempo chapter.
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Tempo Workflows
Overview of Tempo Workflows
This chapter presents typical Tempo example workflows to give you a head start in 
deploying Tempo in your environment.

A minimum of two workflows are required to re-time media using Tempo:

• An Ingest Workflow is needed to ingest media, create proxy and thumbnail files, 
and register the files into the catalog used in the Tempo Portal.

• A Tempo Re-Timing Worklow is required to receive the Portal XML composition 
document that identifies the original media file to re-time and provides re-timing 
instructions. The workflow output is a re-timed media file.
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Ingest Workflow
Any simple ingest workflow can be used that receives an original media input file, 
creates a proxy file and a thumbnail file, and registers the files into a catalog. The ingest 
workflow shown in Figure 15 includes these actions:

• A Watch action receives the incoming media file from a watch folder.

• Two Flip actions transcode the incoming media file into a smaller, faster-processing 
QuickTime proxy file and a keyframe JPEG image to use for the thumbnail view. 

The Flip action that generates the proxy file should be configured as follows:

– Use the QuickTime encoder to create a QuickTime H.264/AAC MOV proxy file 
with a timecode track included in the container. 

– The encoded proxy file must have the same frame rate and timecode notation as 
your original production media. 

– For SD proxies (4:3) use a 640 x 480 frame size. For HD proxies (16:9) use 640 x 360. 

– Assign the nickname Vantage Proxy, which the player automatically recognizes. 

• A Populate action populates a label with helpful information about the media—its 
height, width, frame rate, etc. 

• A Register action registers the binder (original, proxy, and keyframe thumbnail) into 
the Tempo catalog (which must have been created previously).

Once the Tempo catalog contains all the necessary files, you can select it for 
configuring in the Tempo Portal. The Tempo Portal, in turn, allows you to submit the 
configured job to a Tempo workflow for re-timing.

Figure 15. Tempo Ingest Workflow
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Tempo Re-Timing Worklow
A simple example Tempo workflow is shown in the Figure 16. At a minimum, a Tempo 
workflow must contain these actions:

• A Receive action to receive the XML composition file (CML) from the Portal

• A Tempo action to re-time the original media, producing a re-timed output media file

Figure 16. Simple Tempo Workflow

Receive Action
The Receive action is set up to receive the XML composition file from the Portal. 
Expected Nicknames must be set to CML as shown below.

Figure 17. Configuring the Receive Action 
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Tempo Action
The Tempo action accepts as its initial input an XML document from the Portal 
describing the segmentation of the source program. This XML document is recognized 
by selecting CML as the Input File Nickname (upper left corner of the following figure).

Figure 18. Configuring the Tempo Action 

You can further configure the action by expanding each section, selecting the items in 
the sections, and making detailed selections in the right panel. For example, the figure 
shows the QuickTime output selected on the left and the details that apply to it on the 
right. For descriptions of specific fields, click the M (man page) icon in the upper right 
corner, which brings up the appropriate manual page.

The Tempo action produces the re-timed target media item by either compressing or 
expanding the duration of the program according to the instructions in the XML 
composition file. 

Note that Tempo cannot change the fundamental qualities of the video such as its 
height, width, and frame rate. To do that, you should create an additional transcoding 
workflow to convert the re-timed media to another format.

When configuring the Tempo action, one set of controls deserves deeper discussion. 
When you set Source Video Type to Interlaced, the following selections are available to 
specify the rules for converting interlaced fields to progressive frames:

• Motion Adaptive Deinterlacing/“Smooth Interpolation” turned on (default) —
This is recommended for processing most Interlaced files.
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• Advanced Motion Adaptive Deinterlacing—Functions the same as motion adap-
tive deinterlacing, but allows control over thresholds for what constitutes motion.

• Zero-Motion Compensated Deinterlacing—Frame based may be slow and may 
blur text.

• Motion Compensated Deinterlacing—Frame based may create jagged artifacts 
on straight lines.

Re-timing in Frame mode with Motion Adaptive Deinterlacing is the preferred mode for 
handling static text overlays. Re-timing in Field mode may introduce motion in static 
text overlays.

You can adjust these settings to find the best compromise between video quality and 
clarity of burned in subtitles or static text. When you select Interlaced, sources are 
treated as interlaced even when encoded as progressive.

Here are detailed descriptions of the Interlaced selections:

Table 1. Interlaced Source Video Type Selection Descriptions

Deinterlacing Method Description
Motion Adaptive 
Deinterlacing (default)

Converts every field into a progressive frame. This is 
accomplished by keeping the original field, then 
examining each pixel in the other field to determine 
whether or not it is moving, and then choosing to either 
discard it (if it is moving, to avoid field artifacts), or 
keeping it (if not, to preserve detail).

Advanced Motion 
Adaptive Deinterlacing

When using default settings, functions the same as 
motion adaptive deinterlacing, but allows control over 
thresholds for what constitutes motion. Values are 
measured in luma value differences between pixels; 
lower values will result in less detail, but fewer field 
motion artifacts.

Zero-Motion 
Compensated 
Deinterlacing

Converts every field into a progressive frame. This is 
accomplished by keeping the original field, then 
performing block matching to determine whether a 
given region is moving or not. The noise threshold 
indicates how sensitive the algorithm should be to 
noise; higher values cause the algorithm to treat noise as 
actual object motion. This method is slower relative to 
other methods, and can blur burned-in text, which it 
perceives as motion.

Motion Compensated 
Deinterlacing

Converts every field into a progressive frame. This is 
accomplished by keeping the original field, then 
performing a full motion-vector search to determine 
whether a region of video is in motion, or not. If a 
motion vector is found, it will be used to synthesize 
missing information between fields. This algorithm 
provides the highest quality, but also requires the most 
processing time. It can create jaggies on straight lines.
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XML Composition File
The Tempo feature describes program segmentation using an automatically created 
XML composition document constructed by the Tempo Portal. The composition file 
describes the sequence of media segments, each segment representing a portion of 
the overall program (leader, act, commercial, etc.). The sequence forms a timeline in 
which the time of each segment is determined by the accumulated duration of the 
preceding segments. Tempo supports a single top-level sequence. 

The Tempo Portal forwards the composition document to the Tempo re-timing 
workflow when the Portal operator selects Forward to Workflow. Like an edit decision 
list (EDL), the composition document supplies all the information that the re-timing 
workflow needs to find and process the original media and create re-timed output. 

Populate and Copy Actions
Populate and Copy actions shown in the example are optional.

The Populate action can create a label containing pertinent information about the 
media, including its video height, width, and frame rate. The Tempo Portal can display 
the label information in the Metadata Labels tab.

The Copy action simply copies the re-timed output to any location you prefer.
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Using Tempo
Introduction to Using Tempo
The Vantage™ Tempo feature includes a Tempo Portal that you can use to identify 
source media that you want to re-time, mark segments to include or exclude from re-
timing, and specify how much time expansion or compression to apply from 1% to a 
maximum of 10%. When configuration of re-timing is complete, the Portal generates an 
XML document to describe that processing. The operator selects a Tempo workflow to 
receive the XML document, and the Tempo action in the workflow implements the re-
timing of the media file. 

These topics explain how to use Tempo:

■ Overview of the Tempo Portal

■ Tempo Quick Start

■ Using the Tempo Portal
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Overview of the Tempo Portal
Tempo includes a specially designed portal user interface for re-timing media assets. 
The Tempo Portal configuration is created in the Vantage Management Console 
Workflow Portal Configurations window. This configuration transforms the standard 
Workflow Portal into a Tempo Portal.

The Tempo Portal comprises these main sections (Figure 19):

• Catalogs panel: Lists catalogs available in the Tempo configuration.

• Clip List: Shows media clips (binders) in the catalog available for re-timing.

• Preview Player: Plays media clips. Includes standard player controls

• Tabbed panels: Includes Segment List for configuring segment re-timing and 
other tabs for Metadata Labels, Embedded Metadata, Tempo Settings, and For-
warding to Workflow for sending the completed project to be re-timed.

• Re-time panel: Sets the type and duration or amount of retiming and shows re-
timing details.

Figure 19. Tempo Portal Main Panels
Catalogs Panel List Clips by Details or ThumbnailsClip List

Clip FilterRefresh Catalog

Preview Player Re-Time Panel
Re-Time Details

Segment List
Segment Details

Tabbed Panels
Telestream Tech Writer’s Guide
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When populated with catalogs and clips, the Tempo Portal includes these capabilities:

• Browse clips in the selected Vantage catalog.

• Drag clips into a segment list and view them in a built-in video player. 

• Mark In/Out to identify clip segments and include/exclude them from re-timing.

• Add a graphic overlay (bug) and/or content rating graphic to one or more clips.

• Set exact overall clip duration, or increase/decrease clip time by a percentage.
Telestream Tech Writer’s Guide
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Tempo Quick Start
This topic describes the entire Tempo operational process from start to finish in just a 
few pages. If you follow the steps as you read them, you will have completed your first 
Tempo project when you reach the last step. If you are looking for detailed descriptions 
of the Tempo Portal controls, see Using the Tempo Portal later in this chapter.

Steps to Produce a Tempo Project
To process your media files using Tempo, you need to follow a sequence of operations 
employing workflows and using the Tempo Portal. The overall process follows the order 
of the topics listed below:

■ Configure the Tempo Portal

■ Create Tempo Catalogs

■ Ingest and Register Media, Proxies, and Thumbnails

■ Create a Tempo Re-Timing Workflow

■ Launch and Configure the Portal

■ Configure Proxies for Retiming

■ Forward to the Tempo Workflow

These steps are described briefly in the following topics. For detailed specifics about 
using the Tempo Portal, see Using the Tempo Portal later in this chapter. For details 
about Tempo workflows, see the Tempo Workflows chapter.

Configure the Tempo Portal
Before you can use the Tempo Portal to set up media for re-timing, use the Vantage 
Management Console to create a Workflow Portal configuration. The configuration 
makes the Workflow Portal into a Tempo Portal. 

Also be sure to set the Edit action Session Limit to 2.

For complete instructions, refer to the Configuring Tempo chapter. 

Create Tempo Catalogs
Your media files must be gathered into Vantage catalogs for use in the Tempo Portal. 
Use the Vantage Management Console Catalogs panel to create as many catalogs as 
you will need. For details, see Create Tempo Catalogs in the Configuring Tempo chapter.
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Ingest and Register Media, Proxies, and Thumbnails
Next, create a standard Vantage ingest workflow to perform these tasks:

• Ingest the media you want to re-time

• Create a smaller proxy duplicate of the original file that is faster to process

• Create a thumbnail image of a scene to represent the media in the portal (optional)

• Register the original, proxy, and thumbnail into a Vantage catalog

A typical Ingest Workflow is presented in the Tempo Workflows chapter. 

After creating the workflow, run all of the media you plan to re-time through the 
workflow to register the media files, proxies, and thumbnails into Tempo catalogs.

Figure 20. Typical Ingest Workflow

Create a Tempo Re-Timing Workflow
The next step is to create a re-timing workflow using the Tempo action. This is the 
workflow to which you will forward re-timing instructions from the Tempo Portal. The 
workflow will then process and output the re-timed media file. 

The minimum workflow contains a Receive action configured to receive the XML 
composition file (Expected Nicknames = CML) from the Tempo Portal and a Tempo 
action configured to do the re-timing. For an example Tempo Re-Timing Worklow, see 
the Tempo Workflows chapter. 

Figure 21. Tempo Retiming Workflow
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Launch and Configure the Portal
After completing the preparatory steps, you can begin to use the Tempo Portal:

1. Launch the Workflow Portal by double-clicking the desktop icon.

2. Select File > Change Domain to select your Vantage domain.

3. Select File > Change/Reload Application Configuration and choose the Tempo 
configuration you created in the Vantage Management Console.

The Workflow Portal will be reconfigured into a Tempo Portal, ready to re-time your 
media files.

Figure 22. Tempo Portal

Configure Proxies for Retiming
The Tempo Portal is now ready for configuring your media files to re-time them:

1. Click the catalog in the Catalogs list. The catalog’s proxy media will appear as clip 
icons in the panel to the right of the catalog.

2. Click the Segment List tab to show the list in the lower right panel.

3. Click and drag the clip you want to configure from the media list to the Segment 
List (or right-click the + (plus) button in the Segment List to browse for the media).

4. Click the clip in the Segment List to highlight it. The clip will open in the preview 
player in the lower left panel.
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5. In the player, scrub to the point in the clip where you want the first segment to end, 
and click the Mark Out Mark button in the Segment List Selected Segment panel. 

You can also enter the timecode directly in the Mark Out display, and click Mark. 
Notice that you can also modify the Mark In point and the duration, and you can 
use Go to to set the preview player to a previously set point.

6. Check the desired functions at the bottom of the Selected Segment panel. 

a. Select Segment is part of program if you want to include the marked segment in 
the re-timed program’s duration. Uncheck this option to exclude the segment.

b. Select Re-time this segment if you want to include it in re-timing. Uncheck this 
option to leave it its duration unchanged.

c. Select Branding during segment if you want a graphic bug, such as a network 
logo, displayed during the segment. (The graphic display is configured in the 
Management Console > Application Configurations > Workflow Portal > Tempo 
Configuration > Graphic Settings.)

d. Select Rating graphic at start to insert a maturity rating graphic in the segment. 
This graphic is also specified in Management Console > Application 
Configurations > Workflow Portal > Tempo Configuration > Graphic Settings.

7. Right-click the segment, and select Duplicate to create the next segment with Mark 
In timecode starting where the previous segment ends. 

Figure 23. Duplicating the Configured First Segment

8. Repeat the preceding steps to configure the next segment and to create and 
configure additional segments. 

When finished, you should have divided the whole clip into segments and marked 
them for inclusion/exclusion and re-timing or not.
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9. Select the type of retiming at the bottom of the window, and set the duration or 
amount of change using the timecode controls. These are the choices:

– Select Set total duration to set the overall program to the duration entered from 
1% to 10% longer or shorter than the original.

– Select Increase duration by to increase the overall program duration by the 
amount entered.

– Select Decrease duration by to decrease the overall program duration by the 
amount entered.

The Change line shows how much re-timing you have specified. Green indicates an 
acceptable amount (1% to 10%). Red indicates a change percentage that is not per-
mitted. If red, change the re-timing timecode entry until the line turns green.

Figure 24. Segment Configuration Completed

Forward to the Tempo Workflow
After re-timing configuration is complete, the final step is simply to submit the result to 
the Tempo re-timing workflow:

1. Activate the Tempo re-timing workflow you created earlier.

2. Select the Forward to Workflow tab in the Tempo Portal.

3. Check the Tempo re-timing workflow that you want to use, and click Submit.

This completes the re-timing process. When the workflow completes, your re-timed 
media will appear in the Vantage Store or location you specified. 
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Using the Tempo Portal
This topic describes the Tempo Portal menus and controls in detail:

 Browsing Catalogs and Clips

 Using the Preview Player

 Viewing Metadata Labels

 Viewing and Updating Embedded Metadata

 Specifying Tempo Settings

 Configuring the Segment List

 Adjusting Re-timing

 Forwarding to Workflows
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Browsing Catalogs and Clips
You can browse catalogs and media clips as follows (Table 2 and Figure 25):

Figure 25. Catalog and Clip Controls

Table 2. Catalog and Clip Functions and Controls

Function Controls

Select catalogs Click a catalog in the Catalogs panel to select it and 
show its clips.

Filter clips Click the funnel icon, enter text, and press Enter to 
display clips matching the text. Delete the text and 
press Enter to clear the filter and display all clips.

Refresh the clip list The catalog and clip list doesn’t automatically 
update when jobs change catalog contents. To 
update the list, click the green Refresh arrows.

Delete clips Click the clip and click the red X Delete button.

View by Details or Thumbnails Select Details or Thumbnails from the drop-down 
menu to list clips by icon or text. The detail fields 
are defined in the Management Console > Tempo 
Portal Configuration > Binder Details View.

Sort or rearrange columns Click any column heading to sort the clip detail list, 
and click repeatedly to toggle the sort by 
ascending or descending order. Drag column 
headings to re-arrange the order.

Select a clip for re-timing Select a clip for re-timing by dragging it from the 
Clip List and dropping it onto the Segment List.

Play a clip When you select a clip or segment, its proxy is 
loaded into the player ready for playing.

Catalogs Details or Thumbnails ViewFilter

Clip List (binders)DeleteRefresh
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Using the Preview Player
The following topics describe how to preview media in the Tempo Portal:

 Previewing Proxy Media

 Previewing Non-proxy Media

Previewing Proxy Media
The preview player uses the QuickTime Player behind the scenes to play .MOV proxy 
files, which means that you need to install the QuickTime Player if you don’t have it.

Additional Portal configuration steps should already have included using an ingest 
workflow to create and register proxy files into your Tempo catalogs, as follows:

• Use the QuickTime encoder to create a QuickTime H.264/AAC MOV proxy file with a 
timecode track included in the container. 

• The encoded proxy file must have the same frame rate and timecode notation as 
your original production media. 

• For SD proxies (4:3) a 640 x 480 frame size is recommended. For HD proxies (16:9), a 
640 x 360 frame size works best. 

• Assign the nickname Vantage Proxy, so that the player automatically recognizes and 
displays the proxy file.

Figure 26. Preview Player Controls
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When you select a clip (binder), the player displays any video file nicknamed Vantage 
Proxy, if present. The Vantage Proxy file name is listed directly above the player so you 
know which file you’re playing. 

When media appears in the preview window, you can use the window, keyboard, and 
mouse controls listed in Table 3 to control playback. You can also preview other media 
in the nicknames list, if the QuickTime Player supports the format.

Portal Player Keyboard Controls
The Windows client window, keyboard, and mouse controls are listed in Table 3.

Note: Clicking in the playback controls area, or on the video focuses the preview 
player controls (indicated by the blue focus border). Focusing this area is necessary for 
the “JKL” controls, and also allows you to use the Ctrl hot keys without pressing Ctrl.
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Table 3. Player Controls & Keyboard Shortcuts for Windows Client Media Viewer

Function Controls
Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for -1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 1/4x, 1/2x)
Stop Ctrl+S
Forward Frame Ctrl+F

Ctrl + Mouse Wheel, one frame per wheel click

K held down + L (Forward bump one frame)

L held down with K already pressed (Forward bump repeat 1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)
Forward/Reverse 10 
Frames

Up Arrow (Reverse bump 10 frames)

Right Arrow (Forward bump 10 frames)
Forward/Reverse One 
Second

Mouse Wheel (no modifier keys)—one second per wheel click

Forward/Reverse One 
Minute

Shift + Mouse Wheel—one minute per wheel click

Forward/Reverse One 
Hour

Ctrl + Shift + Mouse Wheel—one hour per wheel click

Reverse Frame Ctrl+B

Ctrl + Mouse Wheel, one frame per wheel click

K held down + J (Reverse bump one frame)

J held down with K already pressed (Reverse bump repeat 1/4 speed)
Mark In Ctrl+I or Ctrl+E
Mark Out Ctrl+O or Ctrl+R
Go to mark in frame Ctrl+Q
Go to mark out frame Ctrl+W
Go to start Ctrl+Home
Go to end Ctrl+End
Audio Mute (toggle) Ctrl+M 
Adjust Volume Drag volume button right or left to adjust volume.
Scroll media Drag media button right or left to scrub (scroll) media.
Duplicate selected clip Ctrl+T (Selects the new clip and sets its mark in to the original clip’s mark 

out, if appropriate)
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Previewing Non-proxy Media
Media with a nickname other than Vantage Proxy may also be played. Select the media 
in the binder list (above the media player) and try these methods:

1. For QuickTime (.mov) files, select the file and use the preview player to play it.

2. To play a QuickTime file outside the embedded media player, right-click the media 
and select Open With Default Program or click the file icon directly above the 
binder list to play the media file in the default program for MOV files.

3. To play MOV files when a default program is not set up to play them, right-click the 
media asset, and select Open Containing Folder or click the folder icon above the 
binder list. You can then right-click the file in the Windows folder and play it using 
Open With to select a program.

4. To play files other than QuickTime, right-click the media and select Open With 
Default Program, or click the file icon directly above the binder list to play the 
media file in the default program for the specified file type.

5. If you don’t have a default program assigned to play a particular file type, right-click 
the media asset, and select Open Containing Folder or click the folder icon above 
the binder list. You can then right-click the file in the Windows folder and play it 
using Open With to select a program.
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Viewing Metadata Labels
When the configuration permits it, you can view metadata labels forwarded by a 
workflow. The label information can be helpful during configuration. For example, the 
Media Properties label shows the video frame rate, width, and height. The metadata 
displayed changes depending on the label.

When you submit a clip, all metadata labels are included. 

Figure 27. Metadata Labels Tab and Panel
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Viewing and Updating Embedded Metadata
When enabled in a configuration, you can view and update the default Embedded 
Metadata defined by the Tempo Portal Configuration (in the Management Console). 
Your configuration may also allow viewing but not changing. 

The following (Table 4 and Figure 28) shows the Embedded Metadata Rating panel. This 
panel allows you to select the content rating system from a drop-down menu, the 
specific Rating from another drop-down menu, and check the rating text to display.

Figure 28. Embedded Metadata Tab and Panel

Table 4. Embedded Metadata Rating Controls

Function Controls

Rating (system) Selects the rating system to use:

- Not Set

- US TV Parental Guidelines

- Canadian English Language Rating

- Canadian French Language Rating

Rating (for this program) Selects the rating to apply to this program. The 
ratings available change with the rating system.

Rating Text Check the box for the rating text that applies. 
Rating text options change with the rating system.
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Specifying Tempo Settings
The Tempo Settings panel (Table 5 and Figure 29) allows you to set options related to 
caption processing and the start of timecode.

Figure 29. Tempo Settings Tab and Panel

Table 5. Tempo Settings Controls

Function Controls

Preserve and re-time captions Selects whether to include and re-time captions 
together with the re-timed media. 

Set timecode at Selects the starting point for re-timed timecode:

- Preserve source timecode

- First frame of program

- Last frame of program

- First frame of output file

- Last frame of output file
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Configuring the Segment List
The Segment List (Table 6 and Figure 30) provides the palette for assembling your re-
timed program. You drag the clip to the list and duplicate it (right-click Duplicate) to 
divide it into multiple segments. 

As segments are created, view them in the player and mark their in and out points to 
assemble a complete program. To locate in and out points, use the player scrubber. The 
in/out timecode displays for the selected segment update automatically as you scrub. 

A Part of program check box allows you to set whether a segment is part of the program 
or not (perhaps you want to remove black segments, for example). A Re-time this 
segment check box lets you include or exclude the segment from re-timing. Check 
boxes also allow you to include or exclude a station bug and rating graphic.

Table 6.  Segment List Controls

Function Controls

Add segment (+)  Click to copy the selected clip from the Catalog clip 
list to the Segment List. You can also drag and drop.

Delete (X)  Click to delete the selected segment.

Up arrow  Click to move the selected segment up in the list.

Down arrow  Click to move the selected segment down in the list.

Mark In Mark the in point in the selected segment by direct 
entry, by using the arrows, or by scrubbing in the 
player, and pressing Mark. 

Mark Out Mark the out point in the selected segment by 
direct entry, by using the arrows, or by scrubbing in 
the player, and pressing Mark.

Go to  Click to set the player position of the selected 
segment to the current Mark In or Mark Out point 
(shown in the timecode display).

Duration Set the duration of the selected segment by direct 
entry. Automatically displays duration as Mark In 
and Mark Out are changed. 

Segment description Enter a text description of the segment (optional).

Segment is part of program Check to include the selected segment in the re-
timed program, or uncheck to exclude.
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Figure 30. Segment List Tab and Panel

Re-time this segment Check to re-time the selected segment, or uncheck 
to exclude.

Branding during segment Check to display the station branding logo during 
the selected segment. The logo is imported in the 
Management Console portal configuration.

Rating graphic at start Check to display the rating graphic during the 
selected segment. The rating is set up in the 
Management Console portal configuration.

Table 6.  (Continued) Segment List Controls

Function Controls
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Adjusting Re-timing
The Re-time panel (Table 7 and Figure 31) allows you to specify how and how much to 
re-time a program. 

After setting up the overall program by marking segments, select whether to re-time by 
changing the total program duration to a specified new duration or by increasing or 
decreasing the duration by a percentage. Then enter the new duration or the amount 
of change by direct entry in the timecode display. 

If the Change line is green after you set the duration/amount, your program is ready for 
re-timing. If the Change line is red, you must alter the duration/amount until the line 
turns green. The minimum re-timing change allowed is 1% and the maximum is 10%.

Figure 31. Re-Time Panel

Table 7. Re-time Panel Controls

Function Controls

Re-time Select how to re-time:

- Set total duration: Re-times a clip to an overall duration 
set in the Duration (timecode) display.

- Increase duration by: Increases overall clip duration by 
the time set in the Amount display.

- Decrease duration by: Decreases overall clip duration by 
the time set in the Amount display

Duration/Amount Specify the overall duration or the amount of duration 
change by timecode direct entry.

Timecode displays - Original duration: Original clip total duration.

- Eligible segments: Total duration of segments selected 
for re-timing.

- Re-timed duration: Projected total duration of segments 
selected for re-timing after re-timing is done.

- Change: Percentage of duration increase or decrease. 
Green indicates an acceptable percentage (1 to 10%). Red 
indicates a disallowed percentage, requiring that you 
change the re-timing duration/amount.
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Forwarding to Workflows
The Forward to Workflows tab and panel (Table 8 and Figure 32) lets you select re-
timing workflows to which you can submit your finished re-timing project. (This panel 
may not be present if Show Forward to Workflows is unchecked in the Management 
Console Tempo configuration. In that case, the Submit button is on the main panel.)

1. Check the workflows to which you want to submit media for re-timing, and press 
the Submit button. 

2. Make any Metadata Label changes in the Submit Jobs window.

3. Press Submit in the Submit Jobs window. 

The workflows must be activated and ready to process, and they must include Receive 
and Tempo actions as described in the Tempo Workflows chapter. Otherwise, an error 
message indicates that the workflow is not running or doesn’t exist.

Figure 32. Forward to Workflows Tab and Panel

You can monitor the re-timing workflow in the Vantage Workflow Designer Job Status 
tab. After the re-timing workflow completes, you can find the re-timed media in the 
Vantage Store or other output location specified by the workflow.

Table 8. Forward to Workflows Submit Jobs Controls

Function Controls
Add Metadata Label  Click to browse and select a label from among the 

labels available with the original media.
Delete (X) Select a label from the list and click Delete to 

delete a label.
List and Parameters Added labels appear in a list on the left, and their 

parameters appear on the right.
Categorize Click to expand categories in the label parameters 

list. Click again to close.
Submit Submits the project to the selected workflows.
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Tempo Portal Menus
Table 9 describes the menu selections in the Tempo Portal.

Table 9. Workflow Portal Windows Client Menus

Menu Selection Description

File Change Vantage Domain Opens a window for selecting a domain 
from all the domains on the network.

Change/Reload 
Application Configuration

Opens a window for selecting the Tempo 
Portal configuration.

Exit Closes the Tempo Portal program.

Options Restore Tips & Warnings Restores Portal tips and warnings display 
after the feature has been disabled.

Hide Tips & Warnings Hides Portal tips and warnings.

Prompt for Login Next 
Time Application is 
Launched

When checked, the Portal requires login 
each time the program is launched, to 
increase security.

Use Clip Start Time When checked, the preview window uses 
the start time defined in the proxy media. 
When unchecked, the start time is zero.

Help Contents Displays a help guide.

Index Displays the index of the help guide.

Search Searches for key words in the guide.

Online Help Displays the Vantage guides available on 
the Telestream web site.

About Displays the Portal version information.
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